
CHAPTER 1-THE APPLE INTERNET ROUTER

The Apple Internet Router consists of a family of AppleTalk Phase 2-
compatible routing products that support both local area and wide area
networking. This chapter provides a brief introduction to the products that
are components of the Apple Internet Router: the Basic Connectivity Package,
the AppleTalk/IP Wide Area Extension, and the AppleTalk/X.25 Wide Area
Extension. You can purchase these products separately.

The Basic Connectivity Package

The Basic Connectivity Package provides router software that allows you to
connect two or more AppleTalk networks to create an internet, in which
connected networks retain their separate identities.

The Basic Connectivity Package includes the Router Manager application
program, which allows you to create setup documents, configure ports on the
router, configure the router for startup, control and troubleshoot router
operation, and monitor network performance. For detailed information about
Router Manager, see Appendix B, "The Router Manager Program."

Using the Basic Connectivity Package, you can configure three types of
AppleTalk ports -- LocalTalk, EtherTalk, and TokenTalk -- and half-routing
ports, which provide connectivity to remote AppleTalk local area networks
(LANs) over point-to-point links that consist of modems communicating over
standard or leased telephone lines.

The AppleTalk/IP Wide Area Extension

With the AppleTalk/IP Wide Area Extension, you can extend the capabilities of
the Apple Internet Router. The AppleTalk/IP Wide Area Extension allows two or
more AppleTalk networks or internets to communicate through a tunnel built on
a TCP/IP network. This router extension provides an IP Tunnel access method
for an Ethernet or Token Ring port on the router Macintosh.

For general information about tunneling, see Chapter 6 of this guide,
"Tunneling Through Foreign Network Systems." For information about
configuring an IP tunneling port, see Using the AppleTalk/IP Wide Area
Extension, included when you purchase the extension.

The AppleTalk/IP Wide Area Extension is available from authorized Apple
resellers. To order the AppleTalk/IP Wide Area Extension, request Apple order
number M8112Z/A.

The AppleTalk/X.25 Wide Area Extension

The AppleTalk/X.25 Wide Area Extension also extends the capabilities of the
Apple Internet Router. The AppleTalk/X.25 Wide Area Extension allows two or
more remote AppleTalk networks or internets to communicate over a point-to-
point link using X.25 protocols. A point-to-point link is a type of half-
routing link. This router extension provides an X.25 access method for a
physical port that corresponds to an Apple Serial NB Card installed in the
router Macintosh.

For general information about half-routing, see Chapter 5 of this guide,
"Half-Routing." For information about configuring an X.25 port to establish a
half-routing link between remote AppleTalk networks or internets, see Using
the AppleTalk/X.25 Wide Area Extension, included with the extension.



The AppleTalk/X.25 Wide Area Extension is available from authorized Apple
resellers. To order the AppleTalk/X.25 Wide Area Extension, request Apple
order number M8111Z/A.

CHAPTER 2-INSTALLING THE BASIC CONNECTIVITY PACKAGE

This chapter provides information about the system requirements for the Apple
Internet Router. It also explains how to install the router software included
in the Basic Connectivity Package on a startup disk, and how to select a user
port and a zone for the router.

System requirements

You need the following system components to install the router software
included in the Basic Connectivity Package and establish communication over
an AppleTalk internet:

- system software version 7.0 or later

- an Apple Macintosh Plus or later model Macintosh computer with at least
four megabytes (MB) of random-access memory (RAM) installed

- a hard disk

- an installed network cabling system

- if the router Macintosh has an Ethernet port, EtherTalk version 2.5 or
later, which you can install using the Installer disks

- if the router Macintosh has a Token Ring port, TokenTalk version 2.5 or
later, which you can install using the Installer disks

!!  IMPORTANT  You can use the Apple Internet Router only on internets in
which all routers are compatible with AppleTalk Phase 2.

Running the router software on a Macintosh Portable or on a Macintosh
PowerBook computer is not recommended.  !!

To obtain the best possible router performance, install the router software
on a Macintosh computer with a microprocessor that runs at a fast clock
frequency.

Depending on the level of performance required on your internet, you can use
the Apple Internet Router as either a dedicated or nondedicated router. A
dedicated router runs on a computer on which no other network services reside
and no other application programs are running, and provides better
performance. A nondedicated router runs on a computer that is providing other
network services concurrently. If the router will typically handle high
levels of internet traffic, you should configure the router Macintosh to
function as a dedicated router.

Installing the router on a startup disk

This section describes how to use the Installer to install the router
software included in the Basic Connectivity Package on the current startup
disk of a Macintosh. The current startup disk must be a hard disk on which
you have already installed System 7 or a later version of system software.



The Apple Internet Router Basic Connectivity Package includes three disks,
the Apple Internet Router Basic Connectivity Installer 1, 2, and 3. Before
installing the router software, you should lock the Installer disks, then
make backup copies of the disks. Lock your backup disks, then use them to
install the router software. Set the original Installer disks aside for use
in the event that your backup disks become damaged.

To install the router software for the ports that are available on the router
Macintosh, follow these steps:

1.  Insert the Installer 1 disk into a floppy disk drive and double-click the
Router Installer 1 icon to open it.

The Installer icon is in the window that appears.

2.  Double-click the Installer icon to open the Installer program.

The Easy Install dialog box appears. The contents of the list of software
that the Installer will place on the hard disk depends on the model of the
Macintosh computer or the network interface cards installed in the Macintosh.

3.  Make sure that the hard disk on which the Installer will place the router
software is the startup disk. If another hard disk is currently selected,
click the Switch Disk button until the name of the startup disk appears.

4.  Click Install to place the listed software on the startup disk.

The Installer begins installing the router software on the startup disk. On-
screen messages report the progress of the installation and ask you to insert
the Installer 2 disk, then the Installer 3 disk, and finally, to reinsert the
Installer 1 disk.

You can cancel the installation at any time, leaving the startup disk
unchanged.

If other application programs are currently running on the Macintosh, a
message informs you that the Installer cannot install the router software on
the startup disk while other application programs are running. To quit other
open programs automatically and install the router software, click Continue.
If you do not want to quit other open programs and install the router
software at this time, click Cancel. The startup disk will remain unchanged.

5.  When you see a message reporting that the installation was successful,
click Restart.

Installing the router software adds a status indicator to the Network control
panel that indicates whether the router is currently on or off, and whether
the router will start automatically when you next start up the router
Macintosh.

Customizing your installation

To customize your installation of the router software, follow these steps:

1.  Insert the Installer 1 disk into a floppy disk drive and double-click the
Router Installer 1 icon to open it.

2.  Double-click the Installer icon to open the Installer program.



The Easy Install dialog box appears.

3.  Make sure that the hard disk on which the Installer will place the router
software is the startup disk. If another hard disk is currently selected,
click the Switch Disk button until the name of the startup disk appears.

4.  Click Customize to select specific software options for installation.

It lists all of the software options available for installation.

5.  Select "Apple Internet Router Basic Connectivity" from the list to
install the Apple Internet Router, then Shift-click any additional items that
you want to install.

If the router Macintosh has an Ethernet port, you must also select EtherTalk.
If it has a Token Ring port, you must also select TokenTalk.

6.  Click Install to place the selected software on the startup disk.

The Installer begins installing the router software on the startup disk. On-
screen messages report the progress of the installation and ask you to insert
other disks as necessary.

You can cancel the installation at any time, leaving the startup disk
unchanged.

If other application programs are currently running on the Macintosh, a
message appears, informing you that the Installer cannot install the router
software on the startup disk while other application programs are running. To
quit other open programs automatically and install the router software, click
Continue. If you do not want to quit other open programs and install the
router software at this time, click Cancel. The startup disk will remain
unchanged.

7.  When you see a message reporting that the installation was successful,
click Restart.

Upgrading from the AppleTalk Internet Router version 2.0

If version 2.0 of the AppleTalk Internet Router is already on the startup
disk, follow these steps when installing the router software:

1.  To open the Router desk accessory, choose Router from the Apple menu.

If the Router Setup window was open when you last closed the Router DA, the
Router Setup window appears.

2.  If the Router Setup window does not appear, choose Router Setup from the
Router menu to open it.

3.  If the router is running, click the Current Status Off button in the
Router Setup window to stop the router.

You must stop the router before installing the Apple Internet Router.

4.  If the Restart Status On button is currently selected, click the Restart
Status Off button to prevent the router from starting when you start up the
router Macintosh.



5.  Close the Router Setup window.

An alert box appears, requesting you to save the changes that you made to the
router setup.

6.  Click Yes to save your changes to the router setup.

7.  Insert the Installer 1 disk into a floppy disk drive and double-click the
Router Installer 1 icon to open it.

8.  Double-click the Installer icon to open the Installer program.

The Easy Install dialog box appears.

9.  Make sure that the hard disk on which the Installer will place the router
software is the startup disk. If another hard disk is currently
selected,click the Switch Disk button until the name of the startup disk
appears.

10.  Click Install to place the listed software on the startup disk.

The Installer begins installing the router software on the startup disk. On-
screen messages report the progress of the installation and ask you to insert
other disks as necessary.

You can cancel the installation at any time, leaving the startup disk
unchanged.

If other application programs are currently running on the Macintosh, a
message appears, informing you that the Installer cannot install the router
software on the startup disk while other application programs are running. To
quit other open programs automatically and install the router software, click
Continue. If you do not want to quit other open programs and install the
router software at this time, click Cancel. The startup disk will remain
unchanged.

11.  When you see a message reporting that the installation was
successful,click Restart.

Installing the Apple Internet Router renames version 2.0 of the AppleTalk
Internet Router as Router 2.0. To use the router setup that you created for
version 2.0 of the router, open Router 2.0 as a setup document.

Connecting networks to the router

Depending on the ports that are present on the router Macintosh, you may be
able to connect LocalTalk, Ethernet, and Token Ring networks.

!!  WARNING  Shut down the router Macintosh before connecting a network to
any of its ports. If you connect any type of network other than a LocalTalk
network to the router Macintosh while it is on, you may damage the computer
or the network interface card to which you are connecting the network. If you
connect LocalTalk network to the router Macintosh while it is on, the router
Macintosh assigns itself a node identifier (node ID) without verifying that
no other device on the network is currently using that node ID. If more than
one device on a network has the same node ID, other devices on the network
cannot access either device until one of the devices is switched off, then on



again.  !!

The model of Macintosh computer used as a router determines the number of
AppleTalk networks that you can connect directly to the router. The modem and
printer ports on the router Macintosh enable you to connect two LocalTalk
networks. If the router Macintosh has a built-in Ethernet port -- for
example, a Macintosh Quadra -- you can connect an Ethernet network to that
port. The expansion slots in the router Macintosh and the network interface
cards installed in them enable you to connect additional networks. The Apple
Internet Router software allows you to connect a maximum of 32 networks
directly to the router. See the manuals that came with the computer for
information about the ports and the number of expansion slots available on
the router Macintosh.

If the router Macintosh does not have a built-in Ethernet port, you must
install a network interface card -- such as an Apple Ethernet NB Card or an
Apple Ethernet LC Card -- in the router Macintosh to connect an Ethernet
network to the router. You must install an Apple Token Ring 4/16 NB Card in
the router Macintosh to connect a Token Ring network to the router. For
information about any of these network interface cards, refer to the manual
that came with the card.

Connecting a LocalTalk network to the router

A router Macintosh has two serial ports -- the printer port and the modem
port. Generally, you should connect a LocalTalk network to the printer port
on the router Macintosh. However, when connecting a second LocalTalk network
to the router, you can use the modem port.

Designating an AppleTalk connection as the user port

Several AppleTalk connections may be available in the Network control panel
on the router Macintosh. You can either use the default LocalTalk Built-In
connection as the user port for nonrouting services available on the
Macintosh when the router is running or designate another AppleTalk
connection as the user port. The user port determines the zone in which the
router Macintosh and any network services provided by that Macintosh reside.

Once you have installed the router software and restarted the Macintosh,
select an AppleTalk connection to designate it as the user port for the
router Macintosh. To select a user port, follow these steps:

1.  Choose Control Panels from the Apple menu.

The Network icon is in the Control Panels window that appears.

2.  Double-click the Network icon to open the Network control panel.

The Network control panel appears.

The Network control panel displays whatever AppleTalk connections are
available on the router Macintosh. The ports available on the router
Macintosh determine the AppleTalk connections installed by the Installer.
Each icon in the Network control panel corresponds to a network that is
connected to a port on the router. The LocalTalk Built-In connection for the
printer port is the default AppleTalk connection. Other AppleTalk connections
that may appear in the Network control panel include an EtherTalk connection
for an Ethernet port, a TokenTalk connection for a Token Ring port, and a



LocalTalk connection for the modem port. The AppleTalk connection currently
in use appears highlighted.

3.  In the Network control panel, select an AppleTalk connection to designate
the corresponding port as the user port.

If you selected a different AppleTalk connection as the user port, the
following alert

box appears:

4.  Click OK.

If you selected a LocalTalk connection as the user port for the router
Macintosh, skip step 5.

If you selected an AppleTalk connection other than LocalTalk as the user
port, one or more other routers are connected to that network, and you have
not previously selected a zone for the router Macintosh, the following dialog
box appears:

!!  IMPORTANT  If this Apple Internet Router is the only router on the
network, you must first start the router, then select a zone for the router.
Follow the instructions in Chapter 3,"Setting Up the Apple Internet Router,"
then follow the instructions in the section "Changing the Router's Zone" in
Chapter 8 to select a zone for the router Macintosh. !!

5.  Select an AppleTalk zone from the list of available zones, then click OK.

Whenever you select an AppleTalk connection other than LocalTalk as the user
port and the connected network has more than one zone, you can select a zone
in which the router Macintosh is to reside. The router Macintosh and any
network services provided on that Macintosh appear in this zone in the
Chooser.

The zone currently selected is highlighted. The router Macintosh remains in
this zone until you select a different AppleTalk connection or select a
different zone. For information about selecting a different zone for the
router, see the section "Changing the Router's Zone" in Chapter 8.

If you don't select a zone for the router Macintosh, the zone specified as
the default zone on a seed router on the network is selected automatically.
For information about seed routers, see the section "Configuring the Router
as a Seed Router or a Nonseed Router" in Chapter 4.

6.  Close the Network control panel.

Note  If the Chooser is open when you change an AppleTalk connection,the
network services shown in the Chooser are not updated. To display the
services that are currently available, close the Chooser, then reopen it. 

CHAPTER 3-SETTING UP THE APPLE INTERNET ROUTER

Once you have installed the router software included in the Basic
Connectivity Package, and selected a user port and a zone for the router, you
can begin setting up the router. Before starting the router, you must create
a setup document and designate it as the startup document. This chapter
explains how to use Router Manager to create a setup document, configure the



router's startup options, specify an administrator's password, and start the
router.

Creating a setup document

Router Manager allows you to create and open multiple setup documents. A
setup document identifies the router and the networks connected to the
router's ports.

A router port consists of a physical port and an access method. A router
Macintosh has at least two physical ports: the printer port and the modem
port. A router may also have other physical ports, such as an Ethernet port
or a Token Ring port.

Each physical port has one or more access methods. Both the printer port and
the modem port support two access methods: LocalTalk and DialUp. The DialUp
access method provides half-routing through an asynchronous modem. Other
types of ports support other access methods. For example, an Ethernet port
supports EtherTalk Phase 2 and, if you have installed the AppleTalk/IP Wide
Area Extension, the IP Tunnel access method. A Token Ring port supports the
TokenTalk and IP Tunnel access methods.

A setup document lists all of the physical ports available on the router and
the access methods available for each physical port. In the setup window, you
can select one or more ports and access methods for configuration. A setup
document lists the following information for each port configured on the
router Macintosh:

- a port description

- the port's current status -- active or inactive

- the port's current settings

To create a setup document, follow these steps:

1.  If Router Manager is not already open, double-click the Router Manager
icon to open Router Manager.

When Router Manager opens for the first time or if you have not yet selected
a setup document for the router to use at startup, an untitled setup document
appears on the desktop. The setup document that the router uses at startup is
referred to as the startup document, and contains the port description,
status, and settings for each port that has been configured. Once you have
selected a startup document, it opens whenever you open Router Manager. For
information about selecting a startup document, see the section "Selecting a
Startup Document" later in this chapter.

If a setup document appears, skip step 2.

2.  If necessary, choose New from the File menu to create a new setup
document.

An untitled setup document appears on the desktop.

3.  In the setup window, type a name in the Router Name text box if you want
to assign a different name to the router Macintosh.



The name of the Macintosh on which the router is installed appears in the
Router Name text box by default. A router name must be 32 or fewer characters
in length. A router name that consists only of the equal sign (=) character
is not allowed.

4.  Double-click a physical port, or click the right-pointing triangle to the
left of that port, to display the access methods that are available for that
port.

If the access methods for a port are currently displayed, click the downward-
pointing triangle to the left of that port and the access methods will no
longer be listed. 

!!  IMPORTANT  When creating a setup document, you must configure the
port designated as the user port.  !!

5.  Double-click an access method for the port that you want to configure.

Alternatively, you can click an access method to select it, then choose
Define Port Info from the Edit menu.

A Port Info dialog box appears in which you can configure the port. 

The Port Info dialog box displays the name of the setup document, and the
physical port and access method being configured.

6.  In the Port Info dialog box, type a port description in the Port
Description text box.

The name of the physical port appears in the Port Description text box by
default. You can specify an optional port description to help you to identify
the network connected to the port. A port description can be up to 31
characters in length and can contain any characters, including the space
character.

7.  Configure the port.

The procedure for configuring a port varies, depending on the type of port
and the access method being configured. The Apple Internet Router supports
three types of router ports:

- AppleTalk ports -- through which a LocalTalk, EtherTalk, or TokenTalk
access method provides connectivity between local internets of the same type
or different types

- half-routing ports -- through which the DialUp or another access method
provides point-to-point connectivity

- tunneling ports -- through which an access method for a foreign network
system provides multipoint connectivity

The following road map directs you to the appropriate guides, chapters, and
sections for detailed information about configuring a specific access method
for a port. You need to read only those chapters and sections that pertain to
the port and access method that you want to configure. Once you have
configured all of the ports on the router Macintosh, you must finish creating
your setup document.



To configure . . ..  Do this . . .

A LocalTalk port. Follow the steps in the sections "Configuring a LocalTalk
Port" and "Hiding Devices on an Internet" in Chapter 4 of this guide.

An EtherTalk port.   Follow the steps in the sections "Configuring an
EtherTalk or TokenTalk Port" and "Hiding Devices on an Internet" in Chapter 4
of this guide.

A TokenTalk port

To configure . . ..  Do this . . .

A half-routing port. Follow the steps in Chapter 5 of this guide, "Half-
Routing," and in Chapter 7 of this guide, "Configuring the Wide Area Routing
Options."

An IP Tunnel port.   Follow the instructions in Using the AppleTalk/IP Wide
Area Extension, and in Chapter 7 of this guide,"Configuring the Wide Area
Routing Options."

An X.25 port. Follow the instructions in Using the X.25 Wide Area Extension,
and in Chapter 7 of this guide, "Configuring the Wide Area Routing Options."

8.  In the Port Info dialog box, click the Active button to activate the
port, if it is not already active.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the port being configured from active to inactive by
clicking the Inactive button.

9.  When you have finished specifying your port configuration, click Define
to close the Port Info dialog box.

10.  Repeat steps 4 through 9 for each port that you want to configure.

11.  Name and save your setup document.

If Router Manager encounters an error in the setup information, it will
cancel the save.

Configuring the router for startup

The following sections describe the various startup options that you can
configure for the router.

Selecting a startup document

Before you can start the router, you must select a setup document for the
router to use at startup. This setup document is referred to as the startup
document. To select a startup document, follow these steps:
1.  Choose Set Startup from the Control menu.

The Set Startup dialog box appears.

2.  Click Select.



The following dialog box appears:

3.  Select the setup document that you want to designate as the startup
document in the list box, then click Open.

The name of the startup document that you selected appears beneath the
document icon in the Set Startup dialog box. Router Manager will use this
startup document when you start the router.

4.  Click OK to close the Set Startup dialog box.

Starting the router at system startup

To activate the router automatically when you start up the Macintosh, follow
these steps:

1.  Choose Set Startup from the Control menu.

The Set Startup dialog box appears.

2.  To activate the router when you start up the router Macintosh, click the
"Activate router at Macintosh startup" checkbox to select it, if it's not
already selected.

3.  Click OK.

Note  If "Activate router at Macintosh startup" is selected when you start up
the router Macintosh, you can prevent the router from starting by holding
down the  key until a message informs you that router startup has been
canceled.  

Canceling router startup if an error occurs

If the router encounters an error at startup -- such as a network-numbering
conflict in a port configuration -- it can either continue startup,
activating only ports on which no errors occur, or cancel startup.

By default, the router cancels startup if it encounters an error. If the
"Cancel router startup if an error occurs" checkbox is not selected, the
router starts up and records the status of its ports in the Router Log,
indicating any errors that occur at startup. Any port on which an error
occurred remains inactive until you correct the error, then activate the port
in its Port Info dialog box.

To cancel router startup if an error occurs, follow these steps:

1.  Choose Set Startup from the Control menu.

The Set Startup dialog box appears.

2.  Select "Cancel router startup if an error occurs," if it's not already
selected.
3.  Click OK.

Specifying the routing table's maximum size

The router maintains a routing table that contains the routing information
for each destination network on an internet. For detailed information about



the routing table, see the section "The Routing Table" in Chapter 9. If you
need more memory for other programs running concurrently with the router, you
can reduce the size of the routing table -- that is, the maximum number of
entries that the routing table can contain. Or, to support a greater number
of networks on the internet, you can increase the size of the routing table.

To specify the maximum number of entries that the routing table can contain,
follow these steps:

1.  Choose Set Startup from the Control menu.

The Set Startup dialog box appears. By default, the maximum number of entries
that the routing table can contain is 1024.

2.  Type a number in the Routing Table Entries text box.

The amount of memory installed in the router Macintosh determines the maximum
number of entries that the routing table can contain.

3.  Click OK.

The new maximum number of routing table entries takes effect when you next
restart the router Macintosh.

Specifying the zone table's maximum size

The router maintains a zone table that contains the zone information for each
destination network on an internet. If you need more memory for other
programs running concurrently with the router, you can reduce the size of the
zone table -- that is, the maximum number of entries that the zone table can
contain. Or, to support a greater number of zones on the internet, you can
increase the size of the zone table.

To specify the maximum number of entries that the zone table can contain,
follow these steps:

1.  Choose Set Startup from the Control menu.

The Set Startup dialog box appears. By default, the maximum number of entries
that the zone table can contain is 256.

2.  Type a number in the Zone Table Entries text box.

The amount of memory installed in the router Macintosh determines the maximum
number of entries that the zone table can contain.

3.  Click OK.

The new maximum number of zone table entries takes effect when you next
restart the router Macintosh.

Specifying an administrator's password
To prevent others from opening Router Manager and changing your setup
documents or the router's status, you can specify an administrator's
password.

1.  Choose Set Password from the Control menu.



The following dialog box appears:

2.  Type your password in the Password text box.

A password can have a maximum of eight characters. You can use uppercase and
lowercase letters to distinguish passwords. The characters that you type
appear as bullets to prevent others from learning your password.

3.  Press Tab to move to the Reenter Password text box, then type your new
password again, exactly as you did the first time.

You must type your password exactly as you did before, including your use of
uppercase and lowercase letters. Typing your password again confirms that you
have entered it correctly.

4.  Click OK to turn on password protection.

Once you have set an administrator's password, you must thereafter enter your
password to open Router Manager to edit a setup document or change the
router's status.

Note  To prevent others from making unauthorized changes in Router
Manager, always quit Router Manager when you are not using it.

Always keep a written record of your password. If you forget your password,
you must remove the router software from the startup disk and reinstall the
router software. 

Starting the router

Once you have installed the router, created and saved a setup document, and
selected a startup document, you can start the router at any time without
restarting the router Macintosh. To start the router, follow these steps:

1.  Choose Start Router from the Control menu.

The following alert box appears:

2.  Click Start to confirm that you want to start the router.

Once the router starts, the Start Router command changes to Stop Router. The
router status indicator in the Network control panel indicates that the
router is currently on.

When the router is running:

- Opening or quitting Router Manager does not affect router operation. The
router runs in the background, independent of the Router Manager application
program.

- If you open Router Manager, it displays any windows that were open when
Router Manager was last open.
- You cannot edit setup documents.

- You can activate and deactivate ports on the router, as described in the
section "Activating and Deactivating Ports" in Chapter 8.

- You should not deactivate AppleTalk in the Chooser.



- If you try shutting down the router Macintosh, the following alert box
appears. To confirm you want to shut down the router Macintosh, click OK.

Quitting Router Manager

The Apple Internet Router runs in the background. You can quit Router Manager
after starting the router.

Once you have finished creating setup documents and have configured the
startup options for the router, quit Router Manager. To quit Router Manager,
choose Quit from the File menu.

CHAPTER 4-CONGFIGURING AN APPLETALK PORT

This chapter describes port configuration for three types of AppleTalk ports
-- LocalTalk, EtherTalk, and TokenTalk -- including how to configure the
router as a seed router or a nonseed router, and how to hide devices on an
internet.

Configuring the router as a seed router or a nonseed router

A seed router sends an AppleTalk network's identifying information to all
other routers connected directly to that network. You must configure at least
one router on each AppleTalk network in an internet as a seed router. To
configure the router as a seed router for a network, when configuring the
port to which that network is connected, designate that port as a seed port
and specify the network's identifying information. The sections "Configuring
a LocalTalk Port" and "Configuring an EtherTalk or TokenTalk Port" later in
this chapter describe how to configure seed and nonseed ports.

If more than one router is connected to an AppleTalk network, it is necessary
to specify this identifying information on only one of the connected routers.
However, you can configure more than one router on a network as a seed
router.

!!  IMPORTANT  If more than one router is a seed router for a network,
you must specify exactly the same information for that network when
configuring the seed port on each seed router connected to that network.  !!

A router that obtains the network number or network range and the zone name
or zone list for an AppleTalk network from a seed router connected to that
network is a nonseed router. Once you have configured one seed router for a
network connected to a port, you can configure any additional routers on the
network as either seed or nonseed routers.

A router can be both a seed router and a nonseed router for different
networks. Because a router can function as a seed router for some networks
and a nonseed router for others, the router's ports are designated as seed
ports and nonseed ports. 

Identifying networks on an internet

Networks connected by the router retain separate identities. Each AppleTalk
network in an internet must have a unique network number or network range.

- A single network number identifies a LocalTalk network.



- A network range is a series of contiguous network numbers that identifies
any other type of AppleTalk network, such as an EtherTalk or TokenTalk

network. A network range can neither include a network number already
assigned to another network nor overlap another network range.

Each network in an internet can include a maximum of 253 devices. You can
assign up to 253 devices to each network number in a network range. Thus, a
network range determines the maximum number of devices on a network. For
example, a network having the network range 1-10 could include up to 2530
devices (10  253).

When configuring a seed port on the router, you must assign a unique network
number or network range to the network connected to that port. Router Manager
prevents you from assigning network numbers or ranges that conflict with
those configured for other ports on the router. However, the router cannot
detect conflicting network numbers or ranges on other parts of the internet.
If you assign a number to a network and that number is different from the
number assigned to that network on another seed router, the router will not
be able to start. Maintaining an up-to-date map of the networks in your
internet, which you can refer to when assigning network numbers or ranges,
can help you to avoid assigning duplicate network numbers or overlapping
network ranges.

For more detailed information about assigning network numbers and network
ranges, see the sections "Configuring a LocalTalk Port" and "Configuring an
EtherTalk or TokenTalk Port" later in this chapter, and "Choosing a Network-
Numbering Scheme" and "Specifying Network Ranges" in Appendix A.

Defining AppleTalk zones for a network

When configuring a seed port on the router, you can define one or more
AppleTalk zones for the network connected to that port by assigning a zone
name or zone list to that network. You must define at least one zone for each
AppleTalk network in an internet. A LocalTalk network can have only one zone.
Thus, you can assign only one zone name to a LocalTalk network.

Other types of AppleTalk networks can have multiple zones. Thus, you can
assign a zone list to any other type of AppleTalk network. A zone list
includes all of the zone names assigned to a network and can consist of a
maximum of 255 zone names. You can assign any device on a network to any zone
in the zone list for that network. You must include at least one zone name in
a zone list. For more detailed information about zone names and zone lists,
see the sections "Configuring a LocalTalk Port" and "Configuring an EtherTalk
or TokenTalk Port" later in this chapter, and "Dividing an Internet Into
Zones" in Appendix A.

Configuring a LocalTalk port

To configure a LocalTalk access method for a printer port or modem port,
follow these steps:

1.  Open a setup document.

2.  In the setup window, double-click the physical port that you want to
configure to display the access methods that are available for that port.

A LocalTalk access method is always available for the modem port and for the



printer port.

3.  Double-click the LocalTalk access method.

The LocalTalk Port Info dialog box appears.

4.  In the LocalTalk Port Info dialog box, type a port description in the
Port Description text box.

The name of the physical port appears in the Port Description text box by
default. You can specify an optional port description to help you to identify
the network connected to the port. A port description can be up to 31
characters in length and can contain any characters, including the space
character.

5.  Designate the port as a seed port or a nonseed port. To designate the
port as a seed port, select the Seed button. To designate the port as a
nonseed port, select the Nonseed button.

To configure the LocalTalk port as a seed port, you must assign a network
number and a zone name to the network connected to that port.

A port is designated as a nonseed port by default. You can configure a port
as a nonseed port only if you have already configured a seed router for the
network connected to that port. If you configure the LocalTalk port as a
nonseed port, the router will obtain the network number and zone name for the
network connected to that port from a seed router on the network.

If you are configuring the LocalTalk port as a nonseed port, skip steps 6 and
7.

6.  If you designated the LocalTalk port as a seed port, type a number in the
Network Number text box to assign a number to the network connected to that
port.

You can specify a network number as either a decimal number between 1 and
65,279, or a hexadecimal number between $1 and $FEFF. In Router Manager, a $
character must precede hexadecimal numbers.

!!  IMPORTANT  A network number must be unique in an internet. Do not assign
the same network number to more than one network.  !!

7.  Type the zone name for the network connected to that port in the Zone
Name text box.

A zone name can be up to 32 characters in length and can contain any
characters, including the space character. You cannot use uppercase and
lowercase letters to distinguish zone names. Thus, you can type a zone name
using either uppercase or lowercase letters.

Note  You cannot use a single asterisk () character as a zone name.
AppleTalk protocols use the asterisk as a wildcard character,
signifying "this zone" -- that is, the zone in which the sending
device resides.  

Alternatively, you can select the network's zone name from a list of
connected zones, as described in the next section, "Selecting a Zone Name
From a List of Connected Zones."



8.  To activate the LocalTalk port, select the Active button. To deactivate
the LocalTalk port, select the Inactive button.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the LocalTalk port from active to inactive at any time.

9.  When you have finished specifying the LocalTalk port information, click
Define to close the LocalTalk Port Info dialog box.

Selecting a zone name from a list of connected zones

When configuring a LocalTalk port as a seed port, instead of typing a zone
name for the network connected to that port, you can select a zone name from
a list of zones. To select a zone name from a list of zones, follow these
steps:

1.  In the LocalTalk Port Info dialog box, click Get Zones.

The Get Zones dialog box appears. It lists all of the zones on the internet
connected to the current AppleTalk connection for the router Macintosh.

2.  In the Get Zones dialog box, select a zone name in the list of connected
zones.

When configuring a LocalTalk port, you can select only one zone.

3.  Click OK.

The name of the zone selected appears in the Zone Name text box in the
LocalTalk Port Info dialog box.

Configuring an EtherTalk or TokenTalk port

To configure an EtherTalk access method for an Ethernet port or a TokenTalk
access method for a Token Ring port, follow these steps:

1.  Open a setup document.

2.  In the setup window, double-click the Ethernet or Token Ring port that
you want to configure to display the access methods that are available for
that port.

An EtherTalk access method is available whenever an Ethernet port is present
on the router Macintosh. A TokenTalk access method is available whenever a
Token Ring port is present.

3.  Double-click the EtherTalk or TokenTalk access method.

The EtherTalk or TokenTalk Port Info dialog box appears. 

4.  In the EtherTalk or TokenTalk Port Info dialog box, type a port
description in the Port Description text box.

The name of the physical port appears in the Port Description text box by
default. You can specify an optional port description to help you to identify
the network connected to the port. A port description can be up to 31



characters in length and can contain any characters, including the space
character.

5.  Designate the port as a seed port or a nonseed port. To designate the
port as a seed port, select the Seed button. To designate the port as a
nonseed port, select the Nonseed button.

To configure the EtherTalk or TokenTalk port as a seed port, you must assign
a network range and a zone list to the network connected to that port.

A port is designated as a nonseed port by default. You can configure a port
as a nonseed port only if a seed router has already been configured for the
network connected to that port. If you configure the EtherTalk or TokenTalk
port as a nonseed port, the router will obtain the network range and zone
list for the network connected to that port from a seed router on the
network.

If you are configuring the EtherTalk or TokenTalk port as a nonseed port,
skip steps 6 and 7.

6.  If you designated the EtherTalk or TokenTalk port as a seed port, type
the lowest network number in the network range for the network connected to
that port in the Network Range text box and the highest network number in
the network range in the "to" text box.

!!  IMPORTANT  A network range must be unique in an internet. It can
neither include a network number already assigned to another network nor
overlap another network range.  !!

A network range must consist of a series of contiguous network numbers. You
can specify a network range as two decimal numbers between 1 and 65,279, or
two hexadecimal numbers between $1 and $FEFF. In Router Manager, a $
character must precede hexadecimal numbers. If you don't expect a network to
grow beyond 253 devices, you can assign a single network number to a range --
for example, you can specify a network range from 14 to 14.

7.  Type a zone name in the Zone Name text box, then click Add to add the
zone name to the zone list for the network connected to that port.

You must add at least one zone name to the zone list. A zone name can be up
to 32 characters in length and can contain any characters, including the
space character. You cannot use uppercase and lowercase letters to
distinguish zone names. Thus, you can type a zone name using either uppercase
or lowercase letters.

Note  You cannot use a single asterisk () character as a zone name.
AppleTalk protocols use the asterisk as a wildcard character, signifying
"this zone" -- that is, the zone in which the sending device resides. 

You can add zone names to the zone list in any order. Repeat this step until
you have added all of the network's zone names to the zone list. A zone list
can consist of a maximum of 255 zone names.
Alternatively, you can select zone names to be included in the zone list from
a list of connected zones, as described in the next section, "Including Names
of Connected Zones in the Zone List."

You can rename a zone in the zone list or remove a zone name from the zone
list, as described in the sections "Renaming a Zone in the Zone List" and



"Removing a Zone Name from the Zone List" later in this chapter. You can also
set a default zone for the network connected to the port, as described in the
section "Setting the Default Zone for the Network" later in this chapter.

8.  To activate the EtherTalk or TokenTalk port, select the Active button. To
deactivate the EtherTalk or TokenTalk port, select the Inactive button.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the port from active to inactive at any time.

9.  When you have finished specifying the EtherTalk or TokenTalk port
information, click Define to close the Port Info dialog box.

Adding names from a list of connected zones to the zone list

When configuring an EtherTalk or TokenTalk port as a seed port, instead of
typing each zone name, you can select one or more zone names from a list of
zones on the internet connected to the router's current AppleTalk connection,
and add them to the zone list for the network connected to that port. Follow
these steps to add the zone names to the zone list:

1.  In the EtherTalk or TokenTalk Port Info dialog box, click Get Zones.

The Get Zones dialog box appears. It lists all of the zones on the internet
connected to the current AppleTalk connection for the router Macintosh.

2.  In the Get Zones dialog box, select one or more zone names in the list of
connected zones.

Shift-click to select multiple zone names.

3.  Click OK.

The zone names selected appear in the zone list in the EtherTalk or TokenTalk
Port Info dialog box.

Renaming a zone in the zone list

When configuring an EtherTalk or TokenTalk port as a seed port, follow these
steps to rename a zone in the zone list:

1.  In the EtherTalk or TokenTalk Port Info dialog box, select the name of a
zone in the zone list.

The name appears in the Zone Name text box.

2.  Type the new name for the zone in the Zone Name text box.

3.  Click Rename.

The new name replaces the old name in the zone list.
Removing a zone name from the zone list

When configuring an EtherTalk or TokenTalk port as a seed port, follow these
steps to remove a zone name from the zone list:

1.  In the EtherTalk or TokenTalk Port Info dialog box, select the name of a



zone in the zone list.

The name appears in the Zone Name text box.

2.  Click Remove.

The zone name no longer appears in the zone list.

Note  If you remove the default zone from the zone list, the first
name in the zone list becomes the default zone.  

Setting the default zone

When configuring an EtherTalk or TokenTalk port as a seed port, you can
designate a default zone for the network connected to that port. The first
zone that you add to the zone list for the network connected to the port
automatically becomes the default zone for that network. The router
automatically assigns each device in that network to the default zone. A
device assigned to the default zone resides in that zone until another zone
is selected for the device.

To change the default zone for the connected network, follow these steps:

1.  In the EtherTalk or TokenTalk Port Info dialog box, select a zone name in
the zone list.

2.  Click Set Default.

The zone selected becomes the default zone.

Hiding devices on an internet

Large internets -- for example, local area networks (LANs) that span more
than one department or wide area networks (WANs) that span more than one
organization -- may require device-level security. You can achieve device-
level security by configuring device hiding on AppleTalk ports.

When configuring an AppleTalk port on the router, you can specify that
certain devices on the network or internet connected to that port be hidden
from only one other port or all other ports on the router. Thus, you can
prevent devices on a specific part of the internet or on all other parts of
the internet from accessing the devices for which you specify device hiding.

You can hide any device on the part of the internet that is connected to an
AppleTalk port. A device need not be on the network that is connected
directly to that port. A hidden device does not appear in the Chooser on
computers that are on the part of the internet from which the device is
hidden. However, a hidden device still has access to devices on the part of
the internet from which it is hidden -- that is, those devices appear in the
Chooser on the hidden device.

!!  IMPORTANT  If you want to hide a device and more than one path connects
the device and the part of the internet from which you want to hide the
device,you must hide the device on a router on each path that connects the
device and the internet from which you want to hide the device.  !!

To hide devices connected to an AppleTalk port, follow these steps:



1.  In the Port Info dialog box for an AppleTalk port, click Hide.

The Hide Devices dialog box appears.

2.  In the Hide Devices dialog box, select an option in the Hide pop-up menu
to specify whether devices are to be hidden and how to list the devices.

In the Hide pop-up menu, "only the devices listed" is selected by default. If
you select "all devices except those listed," the devices that you add to the
device list will appear in the Chooser.

If you selected "no devices," skip steps 3 and 4.

3.  Select an option in the "from" pop-up menu to specify whether the devices
are to be hidden from all other ports or from a specific port.

To hide devices from all ports, select "all other ports" in the "from" pop-up
menu. All configured ports on the router appear in the "from" pop-up menu. To
hide devices from a specific port, select that port in the "from" pop-up
menu.

If you selected "all devices" in step 2, skip steps 4 through 7.

4.  Select an option in the Device Type pop-up menu to specify the type of
device to be hidden, or type a specific device type in the Device Type text
box.

The Device Type pop-up menu contains the device types found on the network
connected to the current AppleTalk connection for the router Macintosh. Some
standard device types always appear in the Device Type pop-up menu. The use
of uppercase and lowercase letters does not distinguish device types. Thus,
you can type a device type in the Device Type text box using either uppercase
or lowercase letters.

5.  Select the Name button and type a device name in the Name text box to
hide a specific device of a specific type, or select the All Names button to
hide all devices of that type.

You cannot use uppercase and lowercase letters to distinguish device names.
Thus, you can type a device name in the Name text box using either uppercase
or lowercase letters.

6.  Click Add.

Depending on the selection that you made in the previous step, one of the
following appears in the device list:

- a device type and the name of a specific device

- a device type and "<All >"

You could specify that a device of the type LaserWriter with the name
Gutenberg be hidden from all other ports on the router.

7.  To hide additional devices of specific types, repeat steps 4 through 6
for each device type.



8.  Click OK.

CHAPTER 5-HALF-ROUTING

A half-router is a router that connects two remote AppleTalk networks or
internets. You can achieve wide area connectivity through half-routing, in
which two half-routers connect two remote AppleTalk networks or internets
over a point-to-point link. A point-to-point link is a communications path
that may consist of two modems communicating over a standard telephone line
or a leased line. This chapter explains how to set up a half-routing port to
originate a connection, answer to establish a connection, or call back to
establish a connection.

For information about configuring an X.25 port to establish point-to-point
links between remote AppleTalk networks or internets, see Using the
AppleTalk/X.25 Wide Area Extension.

Configuring a half-routing port

To configure a half-routing port, follow these steps:

1.  Open a setup document.

2.  In the setup window, double-click the physical port that you want to
configure to display the access methods that are available for that port.

A DialUp access method is available for the printer port and the modem port. 

3.  Double-click a DialUp access method to open a DialUp Port Info dialog
box.

A DialUp Port Info dialog box appears.

4.  In the DialUp Port Info dialog box, type a port description in the Port
Description text box.

The name of the physical port appears in the Port Description text box by
default. You can specify an optional port description to help you to identify
the network connected to the port. A port description can be a maximum of 31
characters in length and can contain any characters, including the space
character.

Depending on the method that you want to use to establish a connection,
follow the instructions in one of the subsequent sections to complete the
half-routing port configuration:

- See the section "Originating a Connection" to learn how to originate a
connection.

- See the section "Answering to Establish a Connection" to learn how to
answer to establish a connection.

- See the section "Calling Back to Establish a Connection" to learn how to
call back to establish a connection.

Originating a connection

Using a modem, you can call another exterior router to establish a



connection. To configure the half-routing port to originate a connection,
follow these steps:

1.  In the DialUp Port Info dialog box, click the Call button to select that
mode.

2.  Type your password in the Password text box.

You can provide greater security on your WAN by using an optional password on
half-routing links. The half-router originating the connection sends the
password across the link to another half-router. That half-router verifies
the password before establishing a connection with the half-router
originating the connection.

A password can have a maximum of eight characters. You can use uppercase and
lowercase letters to distinguish passwords.

When you type your password in the Password text box, the characters that you
type appear as bullets to prevent others from learning your password.

3.  Press Tab, then type your password again in the Reenter Password text
box, exactly as you did the first time, to verify that you entered the
password correctly.

You must type your password exactly as you did before, including your use of
uppercase and lowercase letters. Typing your password again confirms that you
have entered it correctly.

4.  Select a modem connected to the router Macintosh in the Connection pop-up
menu.

The Apple Internet Router supports half-routing links using various
asynchronous modems that transmit data at rates of 9600 bits per second (bps)
or greater. You can connect a modem to either the modem port or the printer
port.

5.  Type the phone number that you are calling in the Phone Number text box.

6.  Click the Tone button to select tone dialing. Or, to select pulse
dialing, click the Pulse button.

7.  To select continuous retries, click the Continuous button. Or, to limit
the number of retries, click the "Limit to" button, then type the number
of tries in the text box.

If you select continuous retries, the router will redial until it makes a
connection.

8.  To allow automatic reconnection if the modem loses a connection, click
the "Automatically reconnect if the connection is broken" checkbox to select
it.

9.  To activate the DialUp port, select the Active button. To deactivate the
DialUp port, select the Inactive button.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the DialUp port from active to inactive at any time.



10.  When you have finished specifying the DialUp port information, click
Define to close the DialUp Port Info dialog box.

Answering to establish a connection

To configure the half-routing port to answer a call from another router to
establish a connection, follow these steps:

1.  In the DialUp Port Info dialog box, click the Answer button to select
that mode.

The options appear in the DialUp Port Info dialog box. 

2.  Type the caller's password in the Password text box.

You can use an optional password on a half-routing link. The calling half-
router sends the password across a link to the answering half-router, which
verifies the password before establishing a connection with the calling half-
router.

A caller's password can have a maximum of eight characters. You can use
uppercase and lowercase letters to distinguish passwords. You must type a
caller's password exactly as it was specified, including the use of uppercase
and lowercase letters.

When you type the caller's password in the Password text box, the characters
that you type appear as bullets to prevent others from learning your
password.

3.  Press Tab, then type the caller's password again in the Reenter Password
text box, exactly as you did the first time, to verify that you have entered
the password correctly.

You must type the caller's password exactly as you did before, including the
use of uppercase and lowercase letters. Typing the password again confirms
that you have entered it correctly.

4.  Select a modem connected to the router Macintosh in the Connection pop-up
menu.

The Apple Internet Router supports half-routing links using various
asynchronous modems that transmit data at rates of 9600 bits per second (bps)
or greater. You can connect a modem to either the modem port or the printer
port.

5.  To activate the DialUp port, select the Active button. To deactivate the
DialUp port, select the Inactive button.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the DialUp port from active to inactive at any time.

6.  When you have finished specifying the DialUp port information, click
Define to close the DialUp Port Info dialog box.

Calling back to establish a connection



To provide greater security on your WAN, the router can call back a router
that is calling to establish a connection. If you specify the answer-and-
call-back mode, when the router answers a call from another router, it
verifies the caller's password, if any, then hangs up and calls back the
calling router to establish the connection.

To call back a router to establish a connection, follow these steps:

1.  In the DialUp Port Info dialog box, click the Answer & Call Back button
to select that mode.

The options appear in the DialUp Port Info dialog box. 

2.  Type your password in the Password text box.

You can use an optional password on a half-routing link. The calling half-
router sends the password across a link to the answering half-router, which
verifies the password before establishing a connection with the calling half-
router.

A caller's password can have a maximum of eight characters. You can use
uppercase and lowercase letters to distinguish passwords. You must type a
caller's password exactly as it was specified, including the use of uppercase
and lowercase letters.

When you type the caller's password in the Password text box, the characters
that you type appear as bullets to prevent others from learning your
password.

3.  Press Tab, then type your password again in the Reenter Password text
box, exactly as you did the first time, to verify that you entered the
password correctly.

You must type the caller's password exactly as you did before, including the
use of uppercase and lowercase letters. Typing the password again confirms
that you have entered it correctly.

4.  Type the phone number of the calling router in the Phone Number text box.

5.  To select tone dialing, click the Tone button. Or, to select pulse
dialing, click the Pulse button.

6.  To activate the DialUp port, select the Active button. To deactivate the
DialUp port, select the Inactive button.

When you first configure a port, its status is active by default. When the
router is running, it routes data packets through all active ports. You can
change the status of the DialUp port from active to inactive at any time.

7.  When you have finished specifying the DialUp port information, click
Define to close the DialUp Port Info dialog box.

CHAPTER 6-TUNNELING THROUGH FOREIGN NETWORK SYSTEMS

Tunneling allows you to connect two or more native local area networks (LANs)
or internets through a foreign network system or half-routing link, providing
wide area connectivity. The Apple Internet Router allows native networks or
internets, which communicate using AppleTalk protocols, to connect with one



another through a tunnel built on a foreign network system, which uses some
other protocol family. This chapter provides a general description of the
tunneling capabilities of the Apple Internet Router.

The AppleTalk/IP Wide Area Extension, which you can purchase separately,
allows two or more AppleTalk networks or internets to communicate through a
tunnel built on a TCP/IP network. For information about configuring an IP
tunneling port, see Using the AppleTalk/IP Wide Area Extension.

A tunnel connecting AppleTalk networks or internets functions as a single
virtual data link between those networks or internets. 

Exterior routers

An exterior router is an AppleTalk router with one or more ports connected to
an AppleTalk network or internet, and one or more ports connected to either a
foreign network system or a half-routing link. Thus, an exterior router is a
node on both an AppleTalk network or internet, and on a foreign network
system. Exterior routers use a foreign network system only to connect with
one another and do not provide connectivity to the foreign network system.

An exterior router first encapsulates AppleTalk packets in packets for a
foreign network system, then sends those packets through the foreign network
system to the exterior router that is the next forwarding router. That
exterior router decapsulates the packets, then forwards them to their
destination AppleTalk networks.

Fully connected and partially connected tunnels

Generally, all exterior routers on a tunnel through a foreign network system
can communicate with one another. An exterior router on a tunnel sends the
routing information for only its local internet to other exterior routers on
the tunnel. It does not forward routing information obtained from other
exterior routers on the tunnel, because the other exterior routers exchange
their own routing information.

If all exterior routers connected to a tunnel are aware of and can
communicate with one another, that tunnel is fully connected. 

If some of the exterior routers on a tunnel cannot communicate with one
another, that tunnel is only partially connected.

You can create a partially connected tunnel to provide network-level
security. However, it is also possible to create a partially connected tunnel
inadvertently. An exterior router cannot ascertain whether a tunnel is fully
connected or partially connected. If networks that should be present on the
internet are not listed in the Network Information window in Router Manager,
see Chapter 10, "Troubleshooting."

CHAPTER 7-CONFIGURING THE WIDE AREA ROUTING OPTIONS

This chapter describes some of the wide area routing capabilities of the
Apple Internet Router. It explains how to configure a half-routing or
tunneling port to

- resolve numbering conflicts by remapping remote network numbers

- cluster remapped network numbers



- allow routing distances greater than 15 hops

- cause network traffic to traverse a redundant path, by designating a port
as a backup path or by increasing the routing distance through a port

- hide networks

Resolving numbering conflicts by remapping remote network numbers

Each network in a wide area network (WAN) must have a unique network number
or range. While a half-routing link or tunnel may connect different parts of
a single organization's internet, it often connects an internet that spans
many different organizations. If each organization on a large, global WAN
administrates its internet independently, conflicting network numbers or
ranges may exist. The Apple Internet Router can automatically remap remote
network numbers or ranges on half-routing and tunneling ports to resolve
network-numbering conflicts. Thus, if network-number remapping is enabled,
you need not reconfigure the network numbers or ranges on either part of the
internet to resolve network-numbering conflicts.

When configuring a half-routing or tunneling port, you can specify a range of
AppleTalk network numbers into which the router can remap the network numbers
or ranges for networks accessible through that port. This remapping range --
the range of network numbers reserved for network-number remapping -- must
not conflict with any network numbers or ranges already in use on the
router's local internet. The router maps the network numbers or ranges in
incoming data packets into the remapping range, then maps remapped network
numbers or ranges in outgoing packets back to their actual network numbers or
ranges. To routers and other devices within the router's local internet, the
packets seem to originate from networks having numbers in the remapping
range.

To prevent routers that connect networks that have conflicting network
numbers or ranges from encountering network-numbering conflicts, you must
configure all exterior routers to remap network numbers.

!!  IMPORTANT  Avoid creating an internet layout in which redundant paths
exist between two internets that are connected through a half-routing or
tunneling port on which network-number remapping is enabled. Redundant paths
exist when a router in one internet is connected to a router in another
internet and both internets are connected through a third router. If no
redundant paths exist, the router will activate the port when it starts up
and the port will remain active.

At startup, if the router detects that the activation of a tunneling port on
which network-number remapping is enabled would create a routing loop, it
prevents that port from being activated. If the router detects a loop while
the router is running and network-number remapping is enabled on the
tunneling port creating the loop, it deactivates that port. This prevents any
packets containing remapped network numbers from looping back to the router
that originally remapped those network numbers. If this occurred, it would
appear to the remapping router that the remapped network numbers identified
other networks. Occasionally, when clustering is also active, a router may
be unable to detect a loop. For information about clustering, see the section
"Clustering Remapped Networks" later in this chapter.

If the router allowed a port on which network-number remapping were enabled



to create a loop, when that router received packets containing remapped
network numbers, it would remap the network numbers again and again, until
the number of times the packets containing the remapped network numbers
traversed the loop had exceeded the maximum routing distance of 15 hops.  !!

Remapping remote network numbers

To turn on network-number remapping, follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port, click
Options.

The Options dialog box appears.

2.  Select the "Remap remote network numbers into range" checkbox to turn on
network-number remapping.

Once you turn on network-number remapping, you must specify a range of
network numbers into which remote network numbers are to be remapped.

To turn off network-number remapping, deselect the "Remap remote network
numbers into range" checkbox. If you are turning network-number remapping
off, skip steps 3 and 4.

3.  Type the lowest network number in the range in the "Remap remote network
numbers into range" text box.

4.  Type the highest network number in the range in the "to" text box.

5.  Click OK.

Clustering remapped network numbers

Each router on an internet broadcasts a routing table for each of its
AppleTalk ports at ten-second intervals, allowing the other routers on the
internet to update their routing information. For detailed information about
the contents of a routing table, see the section "The Routing Table" in
Chapter 9.

Broadcasting the routing tables for a large wide area internet -- which might
consist of thousands of networks -- would generate a significant amount of
traffic on the local internet. Therefore, within its local internet, an
exterior router can represent remapped network numbers for a remote internet
connected through a half-routing or tunneling port as a cluster, or a single
extended network consisting of multiple zones. A cluster requires only one
entry in a routing table. Thus, clustering minimizes the amount of routing
traffic generated on the local internet -- that is, traffic caused by the
broadcasting of routing information -- by devices on networks connected
through half-routing or tunneling ports. Clustering also minimizes storage
requirements for routing information on other routers on the local internet.

A router on which clustering is enabled automatically clusters remapped
networks in an internet. For example, a router might create one cluster for
each other router connected to a half-routing link or tunnel. A cluster can
include up to 255 zones.

If networks in an internet had the network ranges 1-10, 100-200, and 1000-
1005, and a router connected to a different part of the internet received



these network ranges through a half-routing or tunneling port, that router
might remap these network ranges to 241-250, 251-351, and 352-357,
respectively. Within its local internet, the remapping router might then
represent the three networks as a single extended network, or cluster, with a
network range from 241 to 357. The router would associate all of the zones in
the three networks with the cluster.

To turn on clustering, follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port on which
network-number remapping is enabled, click Options.

The Options dialog box appears.

2.  Select the "Cluster remapped networks" checkbox to turn on clustering.

To turn off clustering, deselect the "Cluster remapped networks" checkbox.

3.  Click OK.

Some constraints exist on clustering:

- You can cluster only remapped network numbers. If noncontiguous network
numbers -- for example, 1, 1001, and 20345 -- were not remapped before being
clustered, all other numbers within the existing range of numbers would
remain unused.

- All networks in a cluster appear to be the same number of hops away.

- The routing information for a cluster is static. Thus, if a network that is
part of a cluster is disconnected or goes down, the router cannot update the
zone list for the cluster. The zones for a network that is no longer on the
internet would appear in the zone list until all of the networks in that
cluster either were disconnected or went down.

- All networks accessible through a half-routing or tunneling port might not
be in the same cluster. Generally, all networks that are accessible when the
router establishes a half-routing link or tunnel are in one cluster.
However, networks that become accessible later will be in a different
cluster.

Allowing routing distances greater than 15 hops

The distance between two networks in an internet is measured in hops. Each
hop corresponds to a router. A hop count indicates the number of routers
through which a data packet must pass to reach its destination network.

AppleTalk protocols allow a maximum of 15 hops. When a half-router or a
tunnel connects two networks, the distance over which the resulting internet
extends can easily exceed 15 hops. To allow the creation of larger internets,
you can configure a half-routing or tunneling port on which network-number
remapping is enabled to allow routing distances greater than 15 hops through
hop-count reduction. When hop-count reduction is enabled on a port, all
networks accessible out that port appear to be one hop away from all
AppleTalk networks in the router's local internet.

Note  To ensure the proper operation of network-number remapping and



hop-count reduction, no routing loops can exist across the affected link. The
router prevents loops when network-number remapping is enabled. Therefore,
whenever network-number remapping is enabled, an exterior router can perform
hop-count reduction without any risk of a data packet being forwarded in an
infinite routing loop. Hop-count reduction is available only when network-
number remapping is enabled on a half-routing or tunneling port.

To allow more than 15 hops, follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port on which
network-number remapping is enabled, click Options.

The Options dialog box appears.

2.  Select the "Allow more than 15 hops" checkbox to turn on hop-count
reduction.

To turn off hop-count reduction, deselect the "Allow more than 15 hops"
checkbox.

3.  Click OK.

Using redundant paths

Generally, communication over half-routing links or tunnels is much slower
than communication within a LAN and can cause significant delays in packet
forwarding. If more than one path exists between two networks connected
through a half-routing or tunneling port, you can minimize the amount of
traffic on the half-routing or tunneling port by

- designating that port as a backup path

- increasing the routing distance through that port

If you do not designate the half-routing or tunneling port as a backup path,
the router forwards packets over the path having the shortest routing
distance. If the routing distances over redundant paths are the same, the
router may alternately forward packets over each path. If you do not want the
router to forward packets over a half-routing or tunneling port, you can
increase the routing distance through that port, making it the path having
the longest routing distance.

Designating a port as a backup path

To minimize traffic on a slow half-routing link or tunnel on which network-
number remapping is not enabled, you can designate that port as a backup
path. The router uses a backup path to forward AppleTalk data packets only if
the primary path to a specific network becomes unavailable. Generally, the
router uses a backup path only to exchange routing information. To designate
a half-routing or tunneling port as a backup path, follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port, click
Options.

The Options dialog box appears.

2.  Select the "Use this port only as a backup path" checkbox to designate a
port as a backup path.



To stop using a backup path, deselect the "Use this port only as a backup
path" checkbox.

3.  Click OK.

!!  IMPORTANT  Once the router forwards data packets over a backup path,
other routers may continue sending some packets over the backup path rather
than sending them over the primary path when it again becomes available. To
ensure that the routers use only the primary path, you may need to stop
the router on which a port is configured as a backup path, wait ten minutes,
then restart the router.  !!

Increasing the routing distance through a port

The Apple Internet Router provides hop-count weighting to reduce traffic on
slow half-routing links or tunnels. Hop-count weighting effectively increases
the routing distance through a port by a specific number of hops. You can
assign a hop-count weight to a link between two exterior routers, based on
the speed of the link. By increasing the routing distance through a port by a
large number of hops, you can cause traffic to traverse a redundant path, if
such a path is available and the distance to a network over that path appears
to be shorter.

However, you should not increase the routing distance through a port by a
number of hops that would cause routing distances to networks accessible
through that port to exceed the maximum of 15 hops. Otherwise, the router
would be unable to provide full connectivity to all of the networks on the
internet unless a redundant path were available.

To increase the routing distance through a half-routing or tunneling port,
follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port, click
Options.

The Options dialog box appears.

2.  Select the "Increase routing distance by" checkbox to turn on hop-count
weighting.

Once you turn on hop-count weighting, you must specify the number of hops by
which to increase the routing distance.

To turn off hop-count weighting, deselect the "Increase routing distance by"
checkbox.

If you are turning hop-count weighting off, skip step 3.

3.  Type the number of hops by which to increase the routing distance in the
"Increase routing distance by" text box.

4.  Click OK.

Hiding networks in an internet

The Apple Internet Router provides basic network-level security for large
WANs through network hiding.



When configuring a half-routing or tunneling port on the router, you can
specify that certain networks or all networks connected to other ports on the
router be hidden from or shown to other routers connected to that port.
Devices on a part of the internet from which a network is hidden cannot
access the devices on the hidden network. The names of devices on hidden
networks do not appear in the Chooser on computers in the parts of an
internet from which a network is hidden.

!!  IMPORTANT  Devices on a hidden network cannot access devices on the
parts of the internet from which the network is hidden.  !!

To hide or show a network connected to a half-routing or tunneling port,
follow these steps:

1.  In the Port Info dialog box for a half-routing or tunneling port, click
Options.

The Options dialog box appears.

2.  Select an option in the Hide pop-up menu to specify whether networks are
to be hidden and how to list the networks.

In the Hide pop-up menu, "only the networks listed" is selected by default.
If you select "all networks except those listed," only the zones and devices
associated with the networks that you add to the network list will appear in
the Chooser.

If you selected "no networks," skip steps 3 through 5.

3.  To specify the network number or range of a network to be hidden or
shown,type the network number or the first network number in the range in the
"Network range starting with" text box.

4.  Click Add.

The network number appears in the list of network numbers.

5.To hide or show additional networks, repeat steps 3 and 4 for each network.
6.  Click OK.

CHAPTER 8-MODIFYING THE ROUTER SETUP

Using Router Manager, you can activate and deactivate ports at any time.
However, to modify a setup document or change the router's startup options,
you must first stop the router. You can start, stop, or reconfigure the
router without restarting the router Macintosh.

This chapter explains how to

- change the router's zone

- enter an administrator's password to open Router Manager

- activate and deactivate ports

- stop the router



- modify setup documents and port configurations

- designate a different setup document as the startup document and change the
router's other startup options

- customize views of setup windows

- change the administrator's password

- remove password protection from Router Manager

Changing the router's zone

If you designated an AppleTalk connection other than LocalTalk as the user
port for the router Macintosh, you can change the zone in which the router
Macintosh resides at any time. To change its zone, follow these steps:

1.  Choose Control Panels from the Apple menu.

The Control Panels window appears.

2.  In the Control Panels window, double-click the Network icon to open the
Network control panel.

The Network control panel appears.

3.  In the Network control panel, click the AppleTalk connection that is
currently highlighted.

A message asks you to select an AppleTalk zone.

4.  Select a zone from the list of available AppleTalk zones, then click OK.

The router Macintosh remains in this zone until you change the router's
AppleTalk connection or select a different zone for the router.

5.  Close the Network control panel.

Entering your password to open Router Manager
Once you have set an administrator's password, you must thereafter enter your
password to open Router Manager to change a setup document, the status of
either a port or the router, or the router's startup options. To enter the
administrator's password when opening Router Manager, follow these steps:

1.  Double-click the Router Manager icon.

Alternatively, if the router is not running, you can double-click a setup
document's icon to open Router Manager.

The following dialog box appears.

2.  Type the administrator's password in the Password text box.

You must type your password exactly as you did when setting your password,
including your use of uppercase and lowercase letters.

3.  Click OK.



Router Manager opens. If the router is not running and you opened Router
Manager by double-clicking a setup document's icon, that setup document also
opens.

Activating and deactivating ports

When the router is running, it routes data packets through all active ports.
You can change the status of a port -- to active or inactive -- either when
the router is running or when the router is off. When you first configure a
port, its status is active by default. To change the status of a port, follow
these steps:

1.  Open a setup document.

2.  In the setup window, double-click an access method to open a Port Info
dialog box.

3.  In the Port Info dialog box, change the port's status.

- To activate a port that is currently inactive, click the Active button.

- To deactivate a port that is currently active, click the Inactive button.

!!  IMPORTANT  You can deactivate the user port when the router is running.
However, deactivating the user port interrupts users' access to any network
services running concurrently on the router Macintosh. Users cannot access
those services until you reactivate the user port.  !!

4.  Click Define to close the Port Info dialog box.

If the router is running, the change that you made to the port status is
effective only until you next stop the router. If you want to change the port
status temporarily, you are done.

If the router is not currently running, you can change the port status
permanently, as described in step 5.

5.  If the router is not running, choose Save from the File menu to save your
changes to the setup document, permanently changing the port's status.
Stopping the router

You cannot modify setup documents when the router is running. To modify a
setup document, you must first stop the router. To stop the router, follow
these steps:

1.  Choose Stop Router from the Control menu.

The following alert box appears.

2.  Click Stop to confirm that you want to stop the router.

When the router stops running, the Stop Router command changes to Start
Router. The router status indicator in the Network control panel indicates
that the router is currently off.

Once you stop the router, you can modify the startup document or any other
setup document, create a new setup document, or designate a different setup
document as the startup document.



Modifying a setup document

You can modify an existing setup document once you stop the router. To open a
setup document, choose Open from the File menu. The setup document appears on
the desktop.

Adding or changing a port configuration

When the router is not running, you can add port configurations to a setup
document or change a port configuration in a setup document. To configure
another port or change a port configuration, follow these steps:

1.  In a setup window, double-click an access method to open a Port Info
dialog box.

2.  In the Port Info dialog box, configure the port or change the existing
port information.

For instructions on how to configure the port or change the existing port
information, see the following sections:

- To configure a LocalTalk port, see the sections "Configuring a LocalTalk
Port" and "Hiding Devices on an Internet" in Chapter 4 of this guide.

- To configure an EtherTalk or TokenTalk port, see the sections "Configuring
an EtherTalk or TokenTalk Port" and "Hiding Devices on an Internet" in
Chapter 4 of this guide.

- To configure a half-routing port, see "Configuring a Half-Routing Port" in
Chapter 5 of this guide; and "Configuring the Wide Area Routing Options" in
Chapter 7 of this guide.

- To configure an IP tunneling port, see Using the AppleTalk/IP Wide Area
Extension and "Configuring the Wide Area Routing Options" in Chapter 7 of
this guide.

- To configure an X.25 port, see Using the AppleTalk/X.25 Wide Area Extension
and "Configuring the Wide Area Routing Options" in Chapter 7 of this guide.
3.  Click Define to close the Port Info dialog box.

4.  Save your changes to the setup document.

Changing a network number or range

Once you assign a network number or range to an AppleTalk network and run the
router, you should avoid changing that network number or range, if possible.
The network number or range that you specify for an AppleTalk network appears
in the routing tables in all routers on the internet.

!!  IMPORTANT  Changing a network's number or range can cause errors in
internet routing to and from devices on that network. When you start up a
device, it acquires its network number or network range from the router. If
you change a network's number or range, you must restart all devices on that
network to enable them to acquire the new number or range. Otherwise, the
devices on that network will not have the correct network number or range.!!

To change a network number or range, follow these steps:



1.  Stop all routers connected directly to the network for which you are
changing the network number or range to avoid conflicts.

While the routers connected directly to the network for which you are
changing the network number or range are stopped, the devices on that network
cannot access services on other networks, nor can other devices on the
internet access services on that network.

2.  In the Port Info dialog box, change the network number or range.

For instructions on how to specify a different network number, see the
section "Configuring a LocalTalk Port" in Chapter 4. For instructions on how
to specify a different network range, see the section "Configuring an
EtherTalk or TokenTalk Port" in Chapter 4.

3.  Click Define to close the Port Info dialog box.

4.  Save your changes to the setup document.

5.  Repeat steps 2 through 4 for all seed routers connected directly to the
network for which you are changing the network number or range.

!!  IMPORTANT  If more than one router is a seed router for a network, you
must specify exactly the same network number or range when configuring the
seed port on each seed router connected to that network.  !!

6.  After the routers have been off for at least ten minutes, restart the
routers.

The delay purges the network's old network number or range from the routing
tables in all routers on the internet, allowing the routers to acquire the
network's new network number or range when you restart them.

Changing a zone name or zone list

The zone name or zone list that you specify for an AppleTalk network appears
in the routing tables in all routers on the internet and in the Chooser on
each Macintosh on the internet. You should notify network users of any
changes made to zone names or zone lists. To change a zone name or zone list,
follow these steps:

1.  Stop all routers connected directly to the network for which you are
changing the zone name or zone list to avoid conflicts.

While the routers connected directly to the network for which you are
changing the zone name or zone list are stopped, the devices on that network
cannot access services on other networks, nor can other devices on the
internet access services on that network.

2.  In the Port Info dialog box, change the network's zone name or zone list.

For instructions on how to change a zone name, see the section "Configuring a
LocalTalk Port" in Chapter 4. For instructions on how to change a zone list,
see the section "Configuring an EtherTalk or TokenTalk Port" in Chapter 4.

!!  IMPORTANT  Before merging two existing zones -- by giving one zone
the same name as another zone -- verify that all network services of the same



type within the two zones have different names.  !!

3.  Click Define to close the Port Info dialog box.

4.  Save your changes to the setup document.

5.  Repeat steps 2 through 4 for all seed routers connected directly to the
network for which you are changing the zone name or zone list.

!!  IMPORTANT  If more than one router is a seed router for a network,
you must specify exactly the same zone name or zone list when configuring the
seed port on each seed router connected to that network. You can add zone
names to a zone list in any order. The default zone for a network must be the
same on all seed routers connected to the network.  !!

6.  After the routers have been off for at least ten minutes, restart the
routers.

The delay purges the network's old zone name or zone list from the routing
tables in all routers on the internet, allowing the routers to acquire the
network's new zone name or zone list when you restart them.

Removing a device from a list of hidden devices

When reconfiguring an AppleTalk port, you can remove a device from a list of
hidden devices by following these steps:

1.  In the Hide Devices dialog box, select the item to be removed from the
device list.

2.  Click Remove.

The item no longer appears in the device list.

3.  Click OK.

4.  Save your changes to the setup document.

Removing a network from a list of hidden networks
When reconfiguring a half-routing or tunneling port, you can remove a network
number from a list of hidden networks by following these steps:

1.  In the Options dialog box, select the network number to be removed from
the network list.

2.  Click Remove.

The network number no longer appears in the list of network numbers.

3.  Click OK.

4.  Save your changes to the setup document.

Removing a port configuration

When the router is not running, you can remove an existing port
configuration. To remove a port configuration, follow these steps:



1.  In a setup window, select an access method.

2.  Choose Clear Port Info from the Edit menu.

Any information previously specified in the Port Info dialog box for the
selected access method is cleared.

3.  Save your changes to the setup document.

Using a different startup document

Router Manager allows you to create multiple setup documents. When the router
is not running, you can select a different setup document for the router to
use at startup. To select a different startup document, follow the
instructions in the section "Selecting a Startup Document" in Chapter 3.

Changing other router-startup options

When the router is not running, you can change any of the settings in the Set
Startup dialog box. You can turn the options "Activate router at Macintosh
startup" and "Cancel router startup if an error occurs" on or off. You can
also specify the maximum sizes of routing tables and zone tables. For
instructions on how to set these options, see the section "Configuring the
Router for Startup" in Chapter 3.

Customizing your view of a setup window

Router Manager allows you to control the display of information in a setup
window. Once you choose a view, Router Manager uses that view until you
choose a different view.

Displaying a detailed or summary view

You can choose a detailed or summary view of a setup window. By default,
Router Manager displays a detailed view of a setup window. In the View menu,
a checkmark indicates the view that is currently selected

To see a detailed view of a setup window, choose Detailed from the View menu.

A detailed view of a setup window provides the following information:

- all of the router's physical ports

- all access methods available for each physical port

- a port description, the current status, and the current settings for each
port

To see a summary view of a setup window, choose Summary from the View menu.

A summary view of a setup window lists only the physical ports and access
methods that have been configured.

Setting the numeric display format

You can choose a decimal or hexadecimal numeric display format for the
network numbers and ranges displayed in a setup window. By default, Router
Manager displays network numbers and ranges in decimal numbers. In the View



menu, a checkmark indicates the view that is currently selected.

To display network numbers and ranges in decimal numbers, choose Decimal from
the View menu. To display network numbers and ranges in hexadecimal numbers,
choose Hexadecimal from the View menu.

You can specify network numbers and network ranges as either decimal or
hexadecimal numbers, regardless of the current numeric display format. Router
Manager converts all numbers to the current format. In Router Manager, a $
character must precede hexadecimal numbers.

Changing the administrator's password

To change the administrator's password, follow these steps:

1.  Choose Set Password from the Control menu.

The following dialog box appears.

2.  Type your new password in the Password text box.

You can use a maximum of eight characters in your password, and can use
uppercase and lowercase letters to distinguish passwords. The characters that
you type appear as bullets to prevent others from learning your password.

3.  Press Tab to move to the Reenter Password text box, then type your new
password again in the Reenter Password text box, exactly as you did the
first time.

You must type your password exactly as you did before, including your use of
uppercase and lowercase letters. Typing your password again confirms that you
have entered it correctly.

4.  Click OK to change your password.

You must enter your password whenever you subsequently open Router Manager.
You must type your password exactly as you did when setting your password,
including your use of uppercase and lowercase letters.

Removing password protection

To remove password protection from Router Manager, follow these steps:

1.  Choose Remove Password from the Control menu.

The following alert box appears.

2.  Click Remove to verify that you want to remove password protection.

You no longer have to enter an administrator's password to open Router
Manager.

CHAPTER 9-MONITORING THE ROUTER

Router Manager allows you to monitor the operation of the Apple Internet
Router. The Apple Internet Router also supports the Simple Network Management
Protocol (SNMP), which allows a network administrator working at a remote



computer to obtain statistical and other information from the router.

This chapter explains how to use Router Manager to monitor network routing
information, router statistics, and port statistics -- including routing
activity, network reliability, and network errors -- when the router is
running.

When monitoring router operation, you can open multiple windows concurrently
-- including the setup window for the startup document, the Network
Information window, the Router Statistics window, the Port Statistics window,
and the Router Log.

Monitoring network routing information

The Network Information window displays a routing table, which contains the
current routing information for the entire internet. As described in the
sections that follow, you can display a detailed or summary view of the
routing information, display network numbers and ranges as either hexadecimal
or decimal numbers, sort the routing information, and temporarily prevent the
display from being updated. Once you choose a view of the routing
information, Router Manager uses that view until you choose a different view.

When the router is running, choose Network Information from the Windows menu
to display the current routing information for the network. The Network
Information window appears.

The Network Information window displays the current numbers of networks in
and zones on the internet.

The routing table

The router maintains an internal routing table, consisting of entries that
represent the shortest path to each destination network on an internet.
Whenever the router receives routing information from other routers on the
internet, it updates its routing table to reflect any changes to the internet
-- such as networks added to or removed from the internet.

Note  If the router is not a seed router for a network, it can display
that network's routing information in the Network Information window
only after it obtains that information from a seed router on that
network. Thus, once the routers on a network exchange their routing
tables and the router receives the routing information for a network
that is connected to a nonseed port from a seed router for that

network, the router can send packets to that network.

The router displays network ranges and zone lists for networks that
are connected to half-routing and tunneling ports after it remaps and
clusters the network numbers. 

The routing table displayed in the Network Information window lists the
current routing information for each destination network and zone on the
internet. Each entry includes the following information about a destination
network:

- Network Range  The network number or range of network numbers assigned to a
destination network. If a network is connected directly to the router, an
icon at the left of the network range indicates the access method for the
port to which the network is connected.



- Zone Name  The zone name for a destination network.

- Distance  The routing distance in hops from the router to a destination
network. Networks that are connected directly to a router have a routing
distance of zero hops.

- Forwarding Port  The port description for a port through which the router
forwards packets to a destination network. An icon at the left of the
forwarding port indicates the access method for the forwarding port. 

- Next Router  The node address of the next router in the path to a
destination network to which the router is forwarding packets. The next
router is on the network connected to the forwarding port.

The forwarding port to which the next router is connected determines the type
of node address displayed.

- If the forwarding port is a LocalTalk port, the node address of the next
router is its node ID. If the next router is that on which Router Manager is
running, the node address listed for the next router is that of the
forwarding router itself and appears in parentheses.

- If the forwarding port is an EtherTalk or TokenTalk port, the address of
the next router consists of its network number and node ID. If the next
router is that on which Router Manager is running, the node address listed
for the next router is that of the forwarding router itself and appears in
parentheses.

- If the forwarding port is a half-routing port, the next router is
represented as the phone number to which the port is connecting, if that
number is known.

- If the forwarding port is a tunneling port, the next router is represented
as an address in the foreign network system on which the tunnel is built,
rather than as an AppleTalk address. For more information about IP tunneling
ports, see Using the AppleTalk/IP Wide Area Extension.

Using the information in the routing table, the router can determine the most
efficient path over which to forward a data packet to its destination
network.

Displaying a detailed or summary view

You can display either a detailed or summary view of the current routing
information in the Network Information window. By default, Router Manager
displays a detailed view of the routing information. In the View menu, a
checkmark indicates the view that is currently selected.

To see a detailed view of the routing information, choose Detailed from the
View menu. A detailed view provides the following routing information for
each zone in each network on an internet:

- the network's number or range

- the zone's name

- the distance to the network in hops



- the network's forwarding port

- the next router in the path to the network

To see a summary view of the routing information, choose Summary from the
View menu. A summary view of the routing information includes only one entry
for each network on an internet. Only the first zone name in each network's
alphabetical zone list appears in the summary view. When a network has more
than one zone, an ellipsis (...) follows that zone name, indicating that
other zones are present.

Setting the numeric display format

You can choose a decimal or hexadecimal numeric display format for network
numbers and ranges displayed in the Network Information window. By default,
Router Manager displays network numbers and ranges in the routing table in
decimal numbers. In the View menu, a checkmark indicates the view that is
currently selected.

To display network numbers and ranges in decimal numbers, choose Decimal from
the View menu. To display network numbers and ranges in hexadecimal numbers,
choose Hexadecimal from the View menu.

You can specify network numbers and network ranges as either decimal or
hexadecimal numbers, regardless of the current numeric display format. Router
Manager converts all numbers to the current numeric display format. In Router
Manager, a $ character must precede hexadecimal numbers.

Sorting the routing table

You can select a sort key and a sort direction by which to sort the routing
table in the Network Information window.

Selecting a sort key  In the Network Information window, you can sort the
entries in the routing table by network range, zone name, distance, or
forwarding port. By default, the entries are sorted by distance. To sort the
routing table using a different sort key, select the type of information by
which the routing table is to be sorted in the "Sort by" pop-up menu. A
checkmark indicates the type of information by which the routing table is
currently sorted.

The heading of the column containing the type of information by which the
routing table is currently sorted is underlined. 

Note  Alternatively, you can change the sort key by clicking the heading for
the column that contains the type of information by which you want to sort
the routing table. 

Selecting the sort direction  The Network Information window displays the
routing information sorted in ascending order by default -- that is, from A
to Z or from the lowest to the highest number. To sort the routing
information in ascending order, choose Ascending from the View menu. If you
want to sort the routing information in descending order, choose Descending
from the View menu. A checkmark indicates the view that is currently
selected.

Freezing the display



To prevent the display of the routing table temporarily from being updated,
click Pause. The Pause button changes to Resume. To update the routing table
click Resume.

Monitoring network activity and reliability over time

The Router Statistics window displays information about router activity
levels, network reliability, and network error rates. It also allows you to
control the graphing of that information. You can display router statistics
as either bar graphs or line graphs. To open the Router Statistics window,
choose Router Statistics from the Windows menu.

The Router Statistics window allows you to monitor the following information:

- Statistics last reset at  The time and date when the router statistics were
last reset or the router was last restarted.

- Packets Routed  The total number of packets received and forwarded by the
router since the router statistics were last reset or the router was last
restarted. This total includes only AppleTalk packets passing through the
router -- not packets generated by nonrouting services on the user port or
packets generated by software using AppleTalk routing protocols.

- Network Activity  The current level of network activity, or traffic,
through the router, averaged over the selected period and displayed on a
scale of from 0 to 200 packets per second.

- Network Reliability  The percentage of packets routed successfully, without
error.

- Network Errors  The current level of network errors, which is the
proportion of router traffic on which errors occur, averaged over the
selected period and displayed on a scale of from 0 to 10 percent.

Displaying network activity and error statistics as bar graphs

To display network activity and error statistics as bar graphs, follow these
steps:
1.  Choose Bar Graph from the View menu.

A checkmark indicates the view currently selected.

2.  To specify the period of time represented in the graphs, select a time
period in the "Graphs show data for the past" pop-up menu in the Router
Statistics window.

A checkmark indicates the time period currently selected.

Displaying network activity and error statistics as line graphs

To display network activity and error statistics as line graphs, follow these
steps:

1.  Choose Line Graph from the View menu.

The Router Statistics window appears.



2.  To specify the period of time represented in the graphs, select a time
period in the "Graphs show data for the past" pop-up menu in the Router
Statistics window.

A checkmark indicates the time period currently selected.

3.  To specify the maximum number of packets per second represented in the
Network Activity graph, select a number of packets per second in the
Throughput pop-up menu.

A bullet indicates the number of packets per second currently selected.

Monitoring port statistics

The Port Statistics window displays statistics for the ports configured on
the router -- including various types of operations and errors on the
internet. When the router is running, you can choose Port Statistics from the
Windows menu to open the Port Statistics window.

In addition to listing the statistics for each port configured on the router,
the Port Statistics window lists totals for all ports on the router. The
values of the port statistics increase from the time that you start the
router until you reset the router statistics or stop the router. Statistics
for ports that are currently inactive appear in italics. The Port Statistics
window also displays the time and date at which the statistics were last
reset or the router was last restarted.

Monitoring incoming and outgoing traffic

In the Port Statistics window, you can monitor incoming and outgoing traffic
on each port or on the router as:

- Packets In  The total number of packets received for forwarding by the
router since the statistics were last reset or the router was last
restarted, indicating the amount of incoming traffic on a port or on the
router.

- Packets Out  The total number of packets forwarded by the router since the
statistics were last reset or the router was last restarted, indicating the
amount of outgoing traffic on a port or on the router.

Note  The totals for Packets In and Packets Out include only AppleTalk
packets, not packets generated by nonrouting services on the user port
or packets generated by software using AppleTalk routing protocols.  

- Name Requests In  The total number of requests for device names generated
by end nodes and received through a port or by the router. Name Requests
allow end nodes to acquire device names for device lists in the Chooser or in
other networking application programs.

- Name LookUps Out  The total number of name lookups generated by a port or
by the router, in response to incoming name requests. When the router
receives a Name Request, it generates a Name Lookup for each network having a
zone list that contains the zone named in the request.

Monitoring network errors

In the Port Statistics window, you can monitor the following types of network



errors on each port or on the router:

- Data Link Errors  The number of hardware errors encountered on receiving
and forwarding packets.

- Packet Buffer Overflow  The number of packets discarded by the router
because the rate at which it received packets exceeded the rate at which it
could forward the packets and its packet buffer became full.

- Unknown Network  The number of packets discarded by the router because it
received requests to route packets to networks not listed in its routing
table and was unable to forward the packets.

- Hop Count Exceeded  The number of packets not forwarded by the router
because the paths to their destination networks exceeded the maximum routing
distance of 15 hops.

- Routing Table Overflow  The number of routing packets discarded by the
router because the number of AppleTalk networks on the internet exceeded the
router's current maximum number of routing table entries and the router was
unable to add the packets' destination networks to the routing table.

- Local Net Setup Conflicts  The number of routing packets received by the
router that have a different network number or range for the network over
which they were sent than that specified in the current setup for the router
being monitored. Such setup errors occur when a network is connected
directly to two routers and the configurations for the ports to which that
network is connected contain conflicting network numbers or ranges.

- Remote Net Range Conflicts  The number of routing packets received by the
router that indicate a routing table maintained by another router contains a
network range that conflicts with a network range listed in the routing
table in the router being monitored.

- Router Version Mismatch  The number of routing packets received from
another router on the internet that does not support AppleTalk Phase 2.

Resetting router and port statistics

You can reset the statistics that appear in the Router Statistics and Port
Statistics windows, including:

- the number of packets routed displayed in the Router Statistics window,
which indicates the level of router activity

- the numbers of incoming and outgoing packets displayed in the Port
Statistics window, which indicate the amount of traffic over the router

- the numbers of various types of possible network errors displayed in the
Port Statistics window

- the time and date when the statistics were last reset displayed in the
Router Statistics and Port Statistics windows

The number of packets routed and the other port statistics increase from the
time at which you start the router until you reset the statistics or stop the
router. To reset the router and port statistics, follow these steps:



1.  Choose Reset Statistics from the Control menu.

The following alert box appears.

2.  Click Reset.

Router Manager resets the number of packets routed and the values of the
other port statistics to zero, then again begins increasing their values. It
also changes the time and date when the statistics were last reset or the
router was last restarted -- which is displayed in the Router Statistics and
Port Statistics windows -- to the current time and date. Resetting the
statistics does not affect the graphs in the Router Statistics window.

Exporting information

You can save the information in the Network Information and Port Statistics
windows as tab-delimited text in a document that various types of application
programs can read, including spreadsheet and word-processing programs.

To export the network routing information in the Network Information window
or the statistics in the Port Statistics window, follow these steps:

1.  Choose Network Information or Port Statistics from the Windows menu to
open the corresponding window.

2.  Choose Export Data from the File menu to save the information in a text
document that has a tab-delimited format.

The following dialog box appears.

3.  Name and save the document.

Router Manager saves the text in a tab-delimited format.

Printing

You can print the information displayed in any of the following windows:

- a setup window -- including the port information defined in the Port Info
dialog box for each port

- the Network Information window

- the Port Statistics window

- the Router Log


